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1) Popup Blocker Settings
Tools > Internet Options > Privacy

a. Check the box “Turn on Pop-up Blocker” and click on “Settings”

Internet Options @lﬂ

| General | Security | Privacy |Conhent | Connections | Programs I Advanoed|

Settings
Select a setting for the Internet zone.
Medium

- Blocks third-party cookies that do not have a compact

privacy policy

- Blocks third-party cookies that save information that can
] be used to contact you without your explict consent

- Restricts first-party cookies that save information that

can be used to contact you without your implicit consent

[ Sites ] [ Import ] [ Advanced ] Default

Location

" Never allow websites to request your Clear Sites
physical location

Pop-up Blocker

[ Turn on Pop-up Blocker Settings

InPrivate

Disable toolbars and extensions when InPrivate Browsing starts

[ OK ][ Cancel ] Apply

IE Settings for Cognos Access

Note: Cognos also supports Firefox Web Browser to execute and view the reports. However, Chrome Web Browser support is

limited in functionality
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b. Type *.wright.edu in the “Address of websites to allow:” text box and click on “Add” button

C.

Click on “Close” button

d. Click on “Apply” and “OK” button

op-up B r Settings e ———

Exceptions

= Pop-ups are currently blocked. You can allow pop-ups from specific
# ' websites by adding the site to the list below.
-

Address of website to allow:

Add

Allowed sites:

*wrightedu Remove

Remove all ..

Notifications and blocking level:
[ |Play a sound when a pop-up is blocked.
[ | Show Information Barwhen a pop-up is blocked.

Blocking level:

[Medium:BIock most automatic pop-ups v]

Learn more about Pop-up Blocker

Close
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2) Security settings
Tools > Internet Options > Security

a. Click “Custom Level” button

Internet Opticns

General | Security |Privwa::3'-I | Content | Connections | Programs | Ad\ram:edl

|| Select a zone to view or change security settings. |

@ & v O

Internet  Localintranet Trusted sites  Restricted
sites

T
ites

This zone contains websites that you

trust not to damage your computer or

your files.
‘fou have websites in this zone.

Security level for this zone

Custom
Custom settings.
-To change the settings, didk Custom level.
-To use the recommended settings, dick Default level.

[T]Enable Protected Mode (requires restarting Internet Explorer)

[ Custom level... ][ Default level l

l Reset all zones to default level ]

[ 0K H Cancel H Apply ]
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Scroll down till you reach the Downloads section
Set “Automatic prompting for file downloads” to Enable.

Click on “OK” button
Click on “OK” button

If IE version 9 or higher, you do not see “Automatic prompting for file downloads “option (to check IE version, go to “Help” and
select “About Internet Explorer”

Security Settings - Internet Zone . 2{

Settings

l‘ﬁ Downloads

| Automatic prompting for file downloads
'f::.‘ Disable
(@) Enable

5 File download
'f::.‘ Disable
(@ Enable
|&% Font download
() Disable
(@) Enable
'f_:.‘ Prompt
|#% Enable .NET Framework setup
'f_:_:' Disable
@ Enable
|| Miscellaneous
|| Access data sources across domains
(@) Disable
< | Il

[m

*Takes effect after you restart Internet Explorer

Reset custom settings

Resetto: | Medium-high (default) VI

I OK

Cancel

)
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3) Scripting settings

Tools > Internet Options > Security > Custom Level

Click on “OK” button
Click on “OK” button

©ao o

Security Settings - Internet Zone L P
- ———— g —— -
Settings
= Scripting -
| Active scripting
() pisable

@ Enable

— P
= Allow Programmatic clipboard access
() pisable
(@ Enable
() Prompt
T RTONT SratiE Dar UpOates via serp
(@) Disable
(©) Enable
= | Allow websites to prompt for information using scripted wint
(@) Disable —
() Enable |i|
= Enable X35 filter
() pisable %
4| 1 | 3

*Takes effect after you restart Internet Explorer

Reset customn settings

Resetto: | medium-high (default) V]

Continue to scroll down till you reach the Scripting section
Set “Allow Programmatic clipboard access” to Enable
Continue to scroll down a little and set “Enable XSS filter” to Disable

Internet Options
—

LB = 1L,

Security Settings - Trusted Sites Zone

Settings

7 Prompt
= .ﬂ_tllow Programmatic dipboard access
() Disable
@ Enable
©) Prompt
| Allow status bar updates via script
7) Disable
@ Enable
7) Disable

=

=| Allow websites to prompt for information using scripted windc

= E_nable XSS filter
@ Disable

2) Enable

& geri

1 _Niezhls
4| mn |

*Takes effect after you restart your computer

Reset custom settings

Reset to:

[ Medium (default) -]
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4) Compatibility settings

a.

Tools > compatibility view

For IE version 9 and higher, select “Compatibility View” and make sure the check mark is on
b. For IE version < 9, select “Compatibility View Settings”

@ http:/fwww.wright.edu/

P-c

{ :%) Wright State University |

Tracking Protection...
ActiveX Filtering

Fix connection problems...
Reopen last browsing session
Add site to Start menu

View downloads
Pop-up Blocker

SmartScreen Filter

File Edit View Favorites [IEGISY Help
Delete browsing history... Ctrl+Shift+Del
InPrivate Browsing Ctrl+Shift+P

Ctrl+J

s
Compatibility View
Compatibility View settings

Subscribe to this feed...
Feed discovery

Windows Update
F12 developertools

OneMote Linked Motes
Skype for Business Click to Call
Send to OneNote

Intemet options

TATE UNIVERSITY

ademics Campus Life

1 This Summer

our summer by taking classes at Wright
th thousands of cour: nd three term
ke the class you need on a schedule that

th Three Easy Steps
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c. Type wright.edu in the “Add this website:” and click on “Add” button”

d. Click on “Close” button

Compatibility View Settings

I/Tﬂ You can add and remove websites to be displayed in
m Compatibility View.

4 C || @ Wright State University

Add this website:

Websites you've added to Compatibility View:

[ Display all websites in Compatibility View
[V] Display intranet sites in Compatibility View
[] Download updated compatibility lists from Microsoft
Learn more by reading the Internet Explorer privacy statement

wright.edu Remove

UNIVERSITY

cademics Campus Life

ve

-Garfias is pushing hard for
nan political

was the lone Ohio

nal Hispanic conference,

s and developed skills that
ite for the Latino community.

anie Patino-Garfias
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1) Loginto Cognos

2.0 Cognos Login

a. Open Internet Explorer (IE) browser and type in “cognos.wright.edu” in the address bar or click on “COGNOS” link under the

“Employee” tab in Wings

b. Type in your User ID (WID) and Password and click on “OK”

Log on Help

Please type your credentials for authentication,

Mamespace:
eDirectory

User ID:

Password:

| 0K || Cancel|

Licensed Materizks - Property of IEM Corp.

& Copyright IBEM Corporation and its licensors
2005, 2012,

IEM, IEM logo, ibm.com and Cognos are
trademarks or registered trademarks of
International Business Machines Corp., registered in
many jurisdictions worldwide. Other preduct and
service names might be trademarks of IEM or other
Companies,
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c. Click on “My Home”

ware

1IBM Cognos content

@ My Inbox
B —

ﬁ?% Administer IBM Cognos content

Show this page in the future

Or8//e@ |

Create a workspace on the web
Author business reports

Query my data

Analyze my business

Author advanced reports

Manage my events

Sasanka Prabhala
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d. Click on “Strategic Information and Business Intelligence Dashboard and Report Portal”

IBM Cognos Connection Sasanka Prabhala logOff | B | | v 8 ¥ launch~ 9~
B%| Public Folders My Folders
Public Folders L,* 71 Q E}; '& @ X X ey :ﬁ
Entries: '»]
1 Name & Modified $ Actions
[] @3 Advancement Announcement: Green - No data problems. All reports should produce expected results. ~ May 5, 2014 8:24:24 AM More...
[] @3 Finance Announcement: Green - No data problems. All reports should produce expected results. May 5, 2014 8:24:51 AM More...
[] @3 Student Announcement: Green - No data problems. All reports should produce expected results. May 30, 2014 9:27:25 AM More...
[] [ TEMPLATES - REPORT STUDIO July 10, 2014 8:46:41 AM More...
[ [ shared Admissions May 20, 2015 11:15:43 AM More...
[ [ shared Adm FinAid Hou Cube December 14, 2010 5:27:44 PM More...
[ [ shared Advancement December 8, 2014 12:17:01 PM More...
[[] [ shared Career Services January 3, 2014 8:53:35 AM More...
[ [ shared Budget May 7, 2015 3:07:49 PM More...
[] [ shared Development for IS April 23, 2015 8:49:40 AM More...
[ [ shared Finance March 11, 2014 9:18:55 AM More...
[] [ shared Finance - WSAT December 12, 2013 8:35:24 AM More...
[[] [ shared Human Resources April 9, 2015 2:46:04 PM More...
L1 _shared Institutional Research February 5, 2015 12:59:30 PM More...
[[] [ SIBI Dashboard and Report Portal May 26, 2015 1:03:03 PM More...
[ 3 sl June 1, 2015 12:55:39 PM More...
- ~

Proposed Layout (Thoughts?)

___ Strategic Information and Business Intelligence Dashboard and Report Portal
. SIBI
___ All other folders
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3.0 Strategic Information and Business Intelligence Dashboard and Report Portal

Strategic Information and Business Intelligenca (SIEI)
Dashboard and Report Portal

FINANCE

@] sTupent HUMAN RESOURCES

Application

Current Reports Compare Reports

= Unlversiy Leves = Agplication
= Cpliege Lavel « Agplicatlon GRA
= Department Lavel - Gandar/Status
= Age GrIup
+ Ethnlcity
- Reglan
= Detalls
* Cuba

Retention (General and Cohort)

Current Reports Compare Reports

= Universty Level (Senaral)
- College Lavel (Ganeral)
= Department Lavel (Genaral)

» Retention (Eeneral)

= Credit Hours/Overall GPA (Seneral)
- Gender’Siatus (Genemdl)

= Age Eroup (General)

- Eihnlcity (General)

= Reglon [(Genaral)

» Detals (Ganeral)

= Cube (Eeneral)

- Retentian by Callega (Cohart)
» Cuba (Cohort)

Strategic Information and Business Intelligence
Location: 327 University Hal
Phone: (537) T75-3292

Fax: (537) 7752834

Wabelte: hifp:weswright 2duwsibl

Gloseary of Terme—]

Enroliment — Focus Areas

Current Reports Compare Reports

Key
Performance
Indicators (KPI)

Current
A~ Reports
Compare
Graduation {General and Cohort) Re ports
Current Reports dmpare Reports
- - E Contact
- Depanment Lavel (Ganeral) Information

+ Cube (Cohort)

Strategic Information and Business Intelligence



Strategic Information and Business Intelligence Dashboard and Report Portal
(Best Known Practices)

. Open Current Reports

- Right mouse click and select “Open in New Tab”
- Opens up the Active Report in a new tab. An additional tab will be opened. A click on the additional tab shows a dialog box
asking “Do you want to close the tab”. Click on “Yes” and close the tab.

Open Compare Reports

- Right mouse click and select “Open in New Tab”

- Select the required prompts from the prompt page and click on “Finish”

- Adialog box opens with options “Open”, “Save”, and “Save As”. You can choose any options but it is recommended to
choose “Save As” option to save the report. An additional tab will be opened. Click on the additional tab shows a dialog box
asking “Do you want to close the tab”. Click on “Yes” and close the tab

. Open Cube

- Right mouse click and select “Open in New Tab”
- The Cube as a separate window. (Note: need additional license to access Cube). An additional Window “IBM Cognos
Software” will be opened. Click on “X” and close the tab

Strategic Information and Business Intelligence



Strategic Information and Business Intelligence Dashboard and Report Portal
(Navigation)

Current Reports

Eligible/Registered

Credit Hours/Overall GPA
Gender/Status

Age Group

Ethnicity

Region

University

o
o
DASHBOARD

Coliege

LEVELS

7]
o]

Very Specific

DETAILS

Compare Reports

Eligible/Registered

Credit Hours/Overall GPA
Gender/Status

Age Group

Ethnicity

Region

DO

University

DASHBOARD

Coliege

LEVELS

@®
o]

Very Specific
Cube

DETAILS
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1) Current Reports — Enroliment
Student > Enrollment > Current Reports > University Level

a. Click on “Registered” link to open Enrollment University Registered/Eligible Detail Report

Enroliment Active Report

. /—/’
Academic Period Campus T
Filter by: pus Type o

I S o Filters

201540 X Al
Registered/Elgble | Credit Hours/GPA | Gender/Status | Age Group | Ethmicty | Region > Ta b be d p ane
Counts College Total Student Type
College of Ed& | College of Egr | College of College of College of fe— Raj Sain School of Schoolof | School of Prof St o] et
P— & Computer | Liberal Ards Wursing & | Science & Math | Education College of Graduste Medicine oA (F131) | (nen Ft-
e S Health fi— Studies 1)
Registred | Gradhate odunung o = B = = 3 = = = s || 20z e e 2 —» Drill-throu gh
Grilld New 51 = 26 75 1 ~ - pag 360 H#L Ed 1
2 4 2 £ 1 & u 54 3
Gl Specal 1 1 1
G Transient 3 3 3 .
ol : s s Date & time
el Special Grad 5 5 5
Refiimit 1 1 1
e s s H
P § 534 2 165 243 232 1 291 108 s s || 246 17e w2 13
e «  m om omom 2 o= B - = CANNOT save
H3Post Secondary 1 1
R - = = s ow . the report
1l First Time Dirsct from HS € 1 1 20 Y
Ol 1t Time Out 45 More 117 f S = B
2 o : 2 2 5 : f ss ES 1
Tl z z i i = = u 217 us H
Ullrgrod Teansnt = 15 i
i 330 581 791 269 595 a2 572 a728 a187 s38 3
Tota 1108 1633 36 s1a as1 223 a6z 104 5 sa || 7174 a7 sam0 16
Eigible | Groduale cdltinuing & 4 B 15 g 5 8 z 1 ase o 8 &
Grild New 4 10 2 1 1 4 1 23 18 5
Gl Readmit 1 1 1 3 3
Gl Spacal 2 12 g
Grjid Transient 4 4 F)
lical 2 23 n
Neliy Special Grad 4 a 4
& n 155 59 1 8 53 7 51 i 55 3se 133 .
Undorqraduste | ffiuing = o = o = m = 2291 oz m
vy 3 B
oflinew 1 1 B
t1gPost Secondary 1 1
(e ton Degree P s i 0 p
i First Tima Diract from HS. 1 1 2 2
o 1t Time Out 45 More 1vr 3 1 i
Refiimit 1 2 1 1 5 5
Transfer 1 1 2 2

194 403 275 82 205 165 294 2362 2,106 255 2

265 558 434 97 253 165 347 72 51 1 2,888 2,472 408 8

Total
Total

May 10,2015 9:26:00 AM
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2) Current Reports — Enrollment
Student > Enrollment > Current Reports > University Level > Registered

- — 3 WRIGHT STATE UNIVERSITY Selected values
WRIGHT STATE Enrollment University Registered/Eligible Detail Report
‘ ) For Academic Period: 201540 For Campus Type: All
College Student Type oy .
Counts College of Ed & Human College of Egr & Con College of Liberal £ College of Science Raj Soin College of Bu: School of Graduate University College Wright State Laki Domestic_Inte[pationa ’ Ad d Itlo n a I deta I I s
Registere Graduate Degree Credential Seeking Continuing 66 72 1
Grad New 18 45
Grad Readmit 7 | 7 .
Total 9 2 1 125 124 1 Date & tlme
Doctoral Confinuing 10 928 89 197 127 69 1
Grad New 3 4 1 8 6 2
Grad Readmit 3 1 4 4
e | § CAN save the
Total 17| 102 9 210 138 m
Masters Continuing 325 522 136 150 258 1602 1059 634 9 re port
Grad New m 23 16 12 26 244 233 "
Total [ 449 549 154 162 290 1877 1323 545 9
Professional Continuing 111 105 6
Grad New | 7
Grad Readmit 2 2
Medical 5 5
Total 125 119 6
Total 557 653 154 254 290 2337 1704 623 10
Non-Degree Non-Degree Continuing 1 32 33 28 3 2
Grad New 10 48 58 42 15 1
Grad Readmit 11 1" 1
Grad Special 1 1 1
Grad Transient 3 5)
New Special Grad 5 5
Transfer 5 5 5
Total " 105 116 95 18 3
Total 1" 105 116 95 18 3
Total 557 653 165 254 290 105 2453 1799 641 13

Strategic Information and Business Intelligence 15



3) Current Reports — Enrollment
Student > Enrollment > Current Reports > University Level > Graduate

a. Click on “Graduate” link to open Enrollment Detail Report

WRIGHT STATE UNIVERSITY
Enrollment Student Detail Report

For Major:  For Credit Hours:

Domestic/nternational | Visa Type| Nation of Citizenship | Current Age| Current Age Group| Gender
Domestic 31 3135 ]

Ethnictty
Black or African-American

Domestic 38 F Unknown
Domestic 30 W Black or African-American
Domestic 25 2125 F Whnte

International (F1-11)  F1 Libya 32 3138 F Foreign, Non-Resident Alien

Domestic 48 48-50 ] Unknown

Domestic 26 ] White

Internatonal (F1-11}  F1 India 0 26:30 W Foreign, Non-Resident Alien
Domestic 26 F Black or African-American
Domestic n 2125 P Whie

Domestic 42 41-45 F White

Domestic 27 26-30 F White

Domestic 38 F Hispanic

International (F1-1}  F1 India z 2125 W Foreign, Non-Resident Alien

For GPA: For Gender: For Status: For Age Group:

For Ethnicity: For Region:

County
OH-Hontgomery

CO-Broomfield

HMO-Clay

OH-Wiami

International

OH-Montgomery

OH-Montgomery

International

OH-Greene

OH-Greene

OH-Clark

OH-Montgomery

OH-Montgomery

International

Region
Raider Country

Out of State

Raider Country

International

Raider Country

Raider Country

International

Raider Country

Raider Country

Raider Country

Raider Country

Raider Country

International

For Acad_Period: 201540 For Enroll Type: Registered For Campus: All For College: For Department: For Student Type: For Student Level: Graduate For Student Populal

No Data Avaiable

No Data Available

o Data Avaiable

No Data Avaiable

No Data Available

SAT-M: 640 SAT-V:

No Data Avalable

No Data Avaiable

SAT-M: 360 SAT-V:

No Data Avalable

No Data Available

/—v Selected values

» Additional details

SATIACT/WSU MathiWSU Writing Test Scores

Date & time

CAN save the
report

ACT-M: 17 ACT-Composite: 18 ACT-Test Date:01-SEP-07 WITH: 02 WMTH-Test Date:16-JUN-08 WWRT: 80 WIWRT-]

580 SAT-Total: 1220 SAT-Test Date:01-JAN-OT WITH: 04 WMTH-Test Date:04-AUG-08

ACTM: 25 ACT-Composite: 213CT Test Date:01-APR-09 WIMTH: 07 WHTH-Test Date:17-APR-10 WWRT: 40 A/WRT-T|

430 SAT-Total: 0780;AT-Test Date:11-NOV-11 ACT-M: 17 ACT-Composite: 17 \CT-Test Date:11-NOW-11 WITH: 02 WWTH-Test Date:08-JUL-91

ACT-M: 14 ACT-Composite: 15\CT-Test Date:11-NOV-11 WITH: 03 WMTH-Test Date:2
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4) Compare Reports — Enroliment
Student > Enrollment > Compare Reports > Registered/Eligible (Prompt Page)

a. After selection, click on “Finish” button to open Enrollment Comparison Registered/Eligible Report

IBM Cognos Viewer - Enroliment Comparison Registered/Eligible Sasanka Prabhala LogOff | f *+1 About .
: » Required prompts
B Keep this version * 3 fod this report ™ Ig
Enroliment Comparison Registered/Eligible
> Optional prompts
Select Academic Period{s)- Select Event: Select Campus (Optional): Select Student Type (Optional):
¥ | F=oTiz0 | MINEEE | (" Wain ( Domestic
[ 201030 (" DAavia (" Lake (" International (F1-J1}
[ 201040 (" DAYT J Deselect (" International (non F1-J1}
I~ 201080 (" ENDOFTERM - Deselet
I~ 201120 (" ENDOFTERM=30
I~ 201130 (" PRIDRTERM10WK
[ 201140 (" PRIORTERM1TWK
[ 201180 (" PRIORTERM1ZWK
™ 201220 (" PRIORTERM13WK
™ 201230 - (" PRIORTERM14WWK -
Select all Deselect all
Select College (Optional) :
(“ Raj Soin College of Business. j
(“ Continuing Education
(" College of Ed & Human Services
(" College of Egr & Computer Sci
(™ School of Graduate Studies
(" College of Liberal Arts
(" Wright State Lake Campus
(" School of Medicine
(“ Colege of Nursing & Health
(“ School of Prof Psychology j
Deselect
Cancel Finish
e ———
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5) Compare Reports — Enrollment

Student > Enrollment > Compare Reports > Registered/Eligible

WRIGHT STATE

WRIGHT STATE UNIVERSITY

Registered Graduate Degree
Non-Degree
Total
Undergraduate Degree

Count
Credential Seeking

Doctoral

Masters

Professional

Total
Non-Degree

Total

FR

Enrollment Comparison Registered/Eligi

Report

Academic Period(s): 201380, 201480

Event: ENDOFTERM .. Campus: .. Student Typg?

College: .. Department(s): .. Major:

I 201380 I

Continuing 111
Grad New 24
Grad Readmit 16
Total 151
Continuing 249
Grad New 22
Grad Readmit 20
Total 21
Continuing 1703
Grad New 808
Grad Readmit 85
Readmit
Total 2706
Continuing 107
Grad New 28
Grad Readmit 1
Wedical 3
Total 139

3287
Continuing 42
Grad New 7
Grad Readmit 8
Grad Special 35
Grad Transient 10
LEAP Non Degree
New Special Grad 1"
Readmit
Transfer
Undergrad Transient
Total 183

183

3470
Continuing 951
Grad Readmit
New First Time Direct from HS. 2069
Other 1st Time Out HS More 1¥1 203
Readmit 38
Transfer 272

201430

Selected values
Comparison
Date & time

CAN save the
report
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6) Compare Reports — Graduation (General)
Student > Graduation (General and Cohort) > Compare Reports > Cube (General)

File Edit View Settings Run Haln

DB XKoo | p-B~ | TrZ-fE-2

[ TEST_GRADUATION_COMPARE_CUBE
# <% College

L o o o o o e

2]

Academic Period
First Minar
Student Level

First Academic Period by Student Level

First Academic Period by Program
Graduation Status
Domestic/International

Award Category

‘fears to Graduate from Program
Mation of Citizenship

Current Age Group

Gender

Ethnidity

Region

Campus

FT/PT Status

Veteran Type

Overall UG Credits Earned

Term Credits Range

Overall UG GPA Range

Overall GR. GPA Range
Combined Acad Standing

IGPA

Mot for Use

2] Measures

. Can download the

- EEE-

Rowis:

¢ College *

M

AT

Undergraduate

E

Columns:

¢ Student Level | [} Gender ¥

Graduate
Gender I:I M F

Gender

Context filker:

report

# 201480 ¥ \
Filters

. User generated
report

College of Ed & Human Services 48 83 131 2

College of Egr & Computer Sci 49 3 52 98 51 149
College of Liberal Arts 75 101 176 9 8 17
College of Mursing & Health 12 94 106 1 28 29
College of Scence & Math 35 62 97 13 22 35
Raj Soin College of Business 74 44 118 29 29 58
School of Medicine 0 0 o 13 3 21
School of Prof Psychology 0 1] 1] 3 14 17
Wright State Lake Campus [ 5 11 1] 1] 1]
College 299 391 690 188 208 396

» Drill through

CAN save the
report

Note: need advanced
user license to access

Strategic Information and Business Intelligence
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7) Compare Reports — Graduation by College (Cohort)
Student > Graduation (General and Cohort) > Compare Reports > Graduation by College (Cohort) (Prompt Page)

IBM Gognos Viewer - Graduation (Cohorts) by College Report Sasanka Prabhala LogOff | fi About Required prompts

Aod this repor!

T

Graduation (Cohorts) - Degrees Awarded by

tw Optional prompts

Event: Graduation Status: Select Student Level {Optional):

End of Term Degree Awarded ()Graduate
lii:lUndergraduale

Deselect

Select First Enrolled College (Optional)
( ) Raj Sein College of Business
(-) Continuing Education A
(-:' College of Ed & Human Services

bl College of Egr & Computer Sci

) School of Graduate Studies

Select Student Type (Optional)

Select Campus (Optional):

=

ray - (
() Domestic )

v
A

I )
Main C:
:)-i: L::.Ie c:rr:p:z () nternational (F1-11) o] College of Liberal Arts
), p () International (non F1-J1) |>-<IWrig§t State Lake Campus
Deselect b 5
Deselect (_)school of Medicine
(_)Cullege of Nursing & Health (¥
(_) School of Prof Peychology
Deselect

Cancel
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8) Compare Reports — Graduation by College (Cohort)
Student > Graduation (General and Cohort) > Compare Reports > Graduation by College (Cohort)

IBM Cognos Viewer Sasanka Prabhala |

Selected values

WRIGHT STATE UNIVERSITY
Graduation (Cohorts) by College Rel Ly Student
For First Enrolled Academic Periog: Event: End of Term
Graduation Status: Degree Awarded For Student Level: For Campus: movement
For Student Type: For First Enrolled College: College of Ed & Human Services
Date & time

Count Raj Soin College of Buginess | College of Ed & Human Services | College of Egr & Computer Sci Likeral Arts | College of Science & Math | No Degree Awarded m

Degree Awarded | Graduate Grad New 2 93 1 69 165
Total 2 1 63 165 C AN
save the
Undergraduate | Mew First Time Direct from HS 1 2 1 1 53 78
Transfor 4 a5 1 1 2 1 12 report
Total 5 67 1 2 3 129 207
Total I 160 1 3 3 198 72
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1) Filter Data

4.0 Basic Excel Functions

a. Right mouse click and highlight the header row
b. On the Data tab, in the Sort & Filter group, click on the “Filter” icon. (Note drop down arrows appear in each column header and

the “Filter” icon is highlighted)

c. Selecting one or more variables from one or more column headers can filter your list to a select list of records that meet your

filtering criteria

d. To stop filtering, click the “Filter” icon. (Note the drop down arrows in each column header will disappear and the “Filter” icon

will no longer be highlighted)

al Az -? i Clea
2B 7
g b

Z}  sort

Filter -
\H;‘* Advanced
Sort & Filter

First Academic Period by Pr

H

Years to Graduate from Program N

Strategic Information and Business Intelligence



2) Sort data

A. Remove Cognos report header and footers

Select all of the rows that appear above the row the contains the column headers

Right mouse click and click “Delete”

Scroll to the bottom of your data file and select and delete any rows that appear below your data
Right mouse click and click “Delete”

o0 oo

Remove header Remove footer
‘ H Sl e Graduation (General) Compare Detail Report - Microsoft Excel hd |ﬂ‘£_ﬁj g = raduation (General) Compare Detail Report - Microsoft Excel E=R0E)
Home Insert Page Layout Formulas Data Review View & e o @ & Home | J=er S e ST e o el - 0 =
- = =] .. © General - B} Conditional Formatting +  G=lnset+ X - p?
e . == = - [ i ing~ S B - Andale WT 107 A
j & Andale WT 4 A = = General ?ﬁCondltmnal Formatting = g=Insert z ‘;v lﬁ _j 2 - . @ $ % o FomatasTable - ¥ pelete - | [g]- Z L]ia
- v - * 0 - B - » & Paste B|7 U-~|ili~ . - . . Sort & Find &
e 2 | o e A @—] § v % » | [Fomatas Table B Delete | (g I ) U~ s 2 P 5 cell syles - EFomat» | 2+ Fiter~ select-
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R1 M 'f' WRIGHT STATE UNIVERSITY M 7117 Graduate” M40 201340 Degree Awarded Domestic Masters Degree. 3
R \ S LT 1 u 1 v ] W [ ] Y ] = 7118
7119
1 WRIGHT STAT 7120  Undergraduate” 2009807 200980 Degree Awarded Domestic Baccalaureate Degree.
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2 7123 | Undergraduate 201040 201120 Degree Awarded Domestic Baccalaureate Degree
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. ] 7125
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On the Data tab, in the Sort & Filter group, click on the “Sort” icon. (Note a Sort dialogue box will open)
In the Sort dialogue box select the column header you would like to sort by from the “Sort by” drop down box

For the column you’ve chosen, select the order you would like to sort the data from the “Order” drop down box
Click “OK”

T R 7 G Clear
zl .z

z .

A

-E, Reapply
\“:? Advanced

Sort & Filter

Sort @ 22
1;%1 Add Level ] ’ X Delete Level ] ’ =3 Copy Level ” . Options... My data has headers
Colurmn Sort On Order
Sortby | Name E values E AtoZ E

Ok

==

Strategic Information and Business Intelligence



d.

3) Create PivotTable

a.

i S

PivotTable Table

-

Tables

b.

Create PivotTable

Choose the data that you want to analyze
@ Select a table or range

Table/Range: | Pagel 11SAS1:SABS2373

Connection name:
Choose where you want the PivotTable report to be placed
@ Mew Worksheet
Existing Waorksheet
Location:

—

2.5

5.3
Use an external dats source

Values” to view your data file in different ways

On the Insert tab, in the Tables group, click on the “PivotTable” icon to open PivotTable dialogue box

In the Create PivotTable dialogue box, click “OK.” (Note a new worksheet will be created)

In the new worksheet you can drag and drop your column headers in either “Report Filter, Column Labels, Row Labels, or
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) |= Graduation (General) Compare Detail Report - Microsoft Exce

< pivottableToots | [L=.B x|
Optiens Desion o @ o &P 23

Home | Insert | Pagelayout Formulas Data Review View Acobat

EE - h fiolne - M- = A j 4 [
] |pal mE ® i ... e = & == R
Picture  Clip Column Sparklines  Slicer Text  Header Symbols
At s - Bpear- O - Box & Footer "# o
Tables llustrations Charts Filter Links Text

A3 - Jx | Row Labels hd

A B < D F G| PivotTable Field List v x
1 =
§ o L[ Gt aF Choose fields to add to report:

| Count of

4 201230 463 [v] Academic Period &
5 201240 160 @
6 201280 326 [EiName
7 201330 369 [ Address
8 201340 137 [Latest Secondary School
9 201380 189 [ Secondary School Reported GPA
10 201430 403 []Latest Post Secondary School
11 201440 127 =| |F6rad adm uG eea
12201480 203 (] campus
13 Grand Total 2377 [JFT/PT Status
14 =
15 [=PP——— %
16
17 Drag fields between areas below:
18 7 Report Filter i Column Labels
19
20
21 B
2
23 T RowLabels T values
24 Academic Period ™ Count of ID -
25
26
27
28 | [[] Defer Layout Update
K 4» | Sheet1 Pagel 1 . 7J [« L ]

Ready |

|[Emm 100% () y]

4) Merge reports into one report

a.

C.

Users can run the same report multiple times using different parameters. Each time the report is run, a new Excel file is

created. These files can be combined into one Excel file.
b. First, screen each data file (see pp. 22-25 above)

Find a data file you want add to another file. In the “Name Box,” enter the range of cells that include all of the data,
excluding the header row, and then hit the “Enter” key. Note all of the data in your first file, excluding the header row will be

highlighted.
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pare Detail

Home Insert Page Layout Formulas

Review

View

Acrobat

“r"'j & General - S=Insert = E - W [ﬁ
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Paste = g o Styles .j* pelete D Sort & Find &
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| 2 | G 2.6_37 Main Full Time College of Ed & Human Services Teacher Education.  CT: Adolescent Young Adult. CT: Adnl&El
3 Main Mot Enrolled College of Ed & Human Services Educational Leadership Organizational Leadership Org
T Main Full Time College of Ed & Human Services Educational Leadership Organizational Leadership Org
T' 2.695 Main Part Time College of Ed & Human Services. Teacher Education Classroom Teacher Clas!
T Lake Full Time College of Ed & Human Services. Teacher Education Earty Childhood Education Early
7 Main Full Time College of Ed & Human Services Teacher Education Early Childhood Education Early
T Main Full Time College of Ed & Human Services Educational Leadership Organizational Leadership Org
T' 3.097 Main Part Time College of Ed & Human Services Educational Leadership Education Leadership Educat
T Lake Part Time College of Ed & Human Services Educational L ip Or izati Lt ip Org
T' 3.188 Main Full Time College of Ed & Human Services Teacher Education CT: Middle Childhood CT: M
f’ 3.188 Main Full Time College of Ed & Human Services Teacher Education Middle Childhood Education Middle
? Lake Full Time College of Ed & Human Services Teacher Education Early Childhood Education Early
T Main Part Time College of Ed & Human Services. Teacher Education Intervention Specialist Interve
F Dayton Full Time College of Ed & Human Services Educational Leadership  Instrl Design Online Learning Instrl C
F Main Full Time College of Ed & Human Services Teacher Education Classroom Teacher Clas!
(17 1 3.947 ain Part Time Colleoe of Ed & Human Services Teacher Education assroom Teacher Clag: ™
M 4 b M| Pagel 1 %1 Il 0
Ready | Average: 4230099838  Count: 49023 Sum: 366411.248 | IEI o 100% (=) (+) B

d. Right click and select “Copy”

e. Inthe second data file (i.e., the one you want to add the data to), scroll down to the last row of data and select the next

empty cell in column A
f. Right click and select “Paste”
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RV RE N EELE: ) =
Paste ==l Font | Alignment Mumber Styles  Cells @' -
- - - - - 2T
Clipboard & Editing
A2374 (" 5 | v
A B C ;
2370 201330 U23458739 Doe, Joe
1371 201230 U23458790 Done, Jane
2372 | 201430 U23456791 Droe, Ray
2373 201430 U23458792 Doe, Mia E
2374 | !
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2377
2378
2379
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M 4 » ¥ pagel 1 %] [i] 4 [m] » [1]
SR [ O —

Strategic Information and Business Intelligence



5.0 Helpful Information

e Cognos Access Request Form

e Cognos Support and Project Request Form

e Security Best Practices

Contact Information: Computing and Telecommunications Services (CATS)
025 Library Annex
Phone: 937-775-4827
Toll-free Number: 1-888-775-4827
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https://wrightstate.service-now.com/nav_to.do?uri=%2Fcom.glideapp.servicecatalog_cat_item_view.do%3Fv%3D1%26sysparm_id%3Db92b4758136066005e7d7d346144b06d%26sysparm_link_parent%3D58ae0e98138ce6004e02b027d144b03b%26sysparm_catalog%3De0d08b13c3330100c8b837659bba8fb4%26sysparm_catalog_view%3Dcatalog_Service_Catalog
https://wrightstate.service-now.com/com.glideapp.servicecatalog_cat_item_view.do?v=1&sysparm_id=0b89a3d7133cae005e7d7d346144b001&sysparm_link_parent=941a27d7133cae005e7d7d346144b0b1&sysparm_catalog=e0d08b13c3330100c8b837659bba8fb4&sysparm_catalog_view=catalog_Service_Catalog
file:///C:/Users/w101svp/Desktop/SIBI/Dashboard_Portal/SIBI-Dashboard_Portal/New_SIBI_Portal/o%09https:/www.wright.edu/information-technology/security/security-best-practices

